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10 Windows XP tips and tools to simplify your work 

 

Launch System Restore from a command prompt in 
Windows XP 

It's not unusual to use System Restore to fix strange Windows XP system behavior—but depending on 
how damaged your system seems to be, you may need to call for more advanced measures. Here's 
how to launch System Restore from a command prompt. 

Note: This tip applies to both Windows XP Home and Windows XP Professional. 

If your Windows XP system begins acting strange, a typical fix is to use System Restore to remove any 
system changes made since the last time you created a Restore Point. However, what if the problem is so 
bad that you can't start Windows XP normally—or even start the system in Safe Mode? 

The good news is you can run System Restore from a command prompt. Here's how: 

1. Restart your computer and press [F8] during the initial startup. 
2. When you see the Windows Advanced Options Menu, select the Safe Mode With A Command 

Prompt option. 
3. Select the Windows XP operating system. 
4. Log on to your computer with an administrator account or with an account that has administrator 

credentials. 
5. Type the following command at a command prompt: 

C:\windows\system32\restore\rstrui.exe 

When you see the System Restore window, the graphics may look odd, but you can still follow the 
onscreen instructions to restore your computer to an earlier state. 

Speed up Windows XP's Search Companion 

Note: This tip applies to both Windows XP Home and Windows XP Professional. Also remember that 
editing the registry is risky; so be sure you've performed a full backup  

There's lots of buzz about Windows Vista's speedy search features, but what can you do to speed up 
Windows XP's Search Companion? Here's how to optimize your search with speed in Windows XP.  

One reason that Windows Vista's Search tool is so fast is that instead of searching your whole hard disk, 
it searches only the Documents folders. So the next time that you pull up Windows XP's Search 
Companion, click All Files And Folders and select My Documents in the Look In drop-down list. This 
prevents the Search Companion from searching the entire hard disk. 

If you want to search documents stored in the root folder, you can still speed up the process by removing 
system folders from the search. Click All Files And Folders, open the More Advanced Options panel, and 
clear the Search System Folders check box. If the Search Hidden Files And Folders check box is 
selected, clear it too. 

If you have a lot of ZIP files (or compressed folders, as Windows XP calls them) on your hard disk, the 
Search Companion will search through each of those as well, albeit more slowly. To prevent the Search 
Companion from searching through compressed folders, either move all your compressed folders to the 
root folder and then configure the Search Companion to search only the My Documents folder or disable 
Windows XP's support for compressed folders. 
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To disable this support, access the Run dialog box, type the command regsvr32 /u zipfldr.dll in the Open 
text box, and click OK. You'll need to restart the system for the change to take effect. (To re-enable 
Windows XP's support for compressed folders, use the command regsvr32 zipfldr.dll.) 

What if the Search Companion is disabled? 
If you've disabled Windows XP's Search Companion interface and are using the Windows 2000 Search 
interface instead, you'll need to make the following adjustments to this tip: 

 To search My Documents, select My Documents from the Look In drop-down list. 

 To remove system folders from the search, click Search Options, select the Advanced Options 
check box, and then clear the Search System Folders check box. (If the Search Hidden Files And 
Folders check box is selected, clear it too.) 

To prevent the searching of compressed folders, you can use the same technique as you would for the 
Search Companion. 

Keep track of multiple Windows XP computers with BGInfo 

Working with multiple Windows XP computers from the same screen? Clear up potential confusion by 
using BGInfo, or Background Information. Here's a look at the benefits of this free program. 

Do you regularly work with multiple computers using a Keyboard Video Mouse (KVM) switch? If so, you 
know that it's easy to get confused about which computer you currently have on the screen. Of course, 
you can find out on your own, but doing so takes several steps and can be distracting—especially if 
you're in the middle of an important or lengthy task. 

Fortunately, there's a solution in a program called BGInfo, which is short for Background Information. 
When Microsoft acquired Sysinternals, it also acquired a whole library of cool little utilities that fall along 
the lines of Microsoft's own PowerToys, and BGInfo is one of them. 

Once installed, BGInfo displays relevant information about a computer on the desktop's background. For 
example, you can configure BGInfo to display the computer name, IP address, service pack version, boot 
time, amount of free space, and much more. You can even choose the font and background color. 

You can download BGInfo from Microsoft's TechNet site. You'll also find detailed instructions on how to 
install and use BGInfo. 

Remove clutter with Windows XP SP2's Duplicate Finder tool 

Hidden clutter exists on your Windows XP machine in the form of duplicate files. Here's how to free up 
valuable hard disk space by doing some spring cleaning with the Duplicate Finder tool. 

Note: This tip applies to both Windows XP Home and Windows XP Professional. 

Even if you're a conscientious computer user (i.e., you regularly delete unnecessary files, empty the 
Recycle Bin, and run Disk Defragmenter), you may be unaware of a potentially big waster of hard disk 
space: duplicate files. Applications can litter your hard disk with duplicate files, and you can create 
duplicate files yourself by copying files from one folder to another. 
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Windows XP's default installation doesn't provide you with a decent utility for tracking down duplicate files. 
However, Microsoft does have a tool called Duplicate Finder, which is part of the Windows XP Service 
Pack 2 Support Tools. Here's how to install and use the Duplicate Finder tool: 

1. Download the Windows XP Service Pack 2 Support Tools and follow the instructions for installing 
the Complete installation version. 

2. Open the Run dialog box by pressing [Windows]R. 
3. Type Dupfinder in the Open text box and click OK. 
4. Once DupFinder loads, simply select the drive or folder to search and then click the Start Search 

button. 
5. When DupFinder completes its search, you can scan through the list and examine the duplicate 

files. 

Here are some tips for working with the list of duplicate files: 

 Use either the Print Report or Export Data command on the File menu to create a permanent 
record of the duplicate files. 

 Use the Sort command on the View menu to reorganize the list for better analysis. 

 To get more detailed information about any file, select the file, pull down the File menu, and select 
the Info command. 

 Leave duplicate files in the Windows folder and its subfolders alone. 

 If you don't recognize the duplicate file, it's better to use the Rename or Move commands on the 
File menu rather than the Delete command. 

Launch Windows Explorer with administrative privileges on 
Windows XP Pro 

Do you ever need to perform an on-the-fly administrative task when you're not on your computer? If 
the computer runs Internet Explorer 6 or 7, you can launch Windows Explorer with administrative 
privileges on a Windows XP Pro limited user machine. 

Note: This tip applies only to Windows XP Professional. 

When you're working on a user's computer and need to perform an administrative task from within his or 
her Windows XP Pro limited user account, you can use the Run As command to launch certain utilities 
with administrative account privileges. 

However, if you try to use Run As to launch Windows Explorer with administrative privileges, nothing 
happens. This is because Explorer.exe is already running and only one instance of Explorer can run at a 
time. More specifically, when you launch Explorer.exe, the first thing it does is check to see whether it is 
already running. When the second instance of Explorer.exe sees that the first instance of Explorer.exe is 
running, the second instance of Explorer.exe closes without any outward notification. Here's how you can 
work around it. 

Internet Explorer 6 
Internet Explorer 6 will work with Run As and will allow you to tap into Windows Explorer. Here's how: 

1. Right-click on the Internet Explorer icon in the Quick Launch toolbar and choose Run As. (Keep in 
mind that you can't access Run As from the Internet Explorer icon that appears on the desktop or 
on the Start menu.) 
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2. Fill in the appropriate administrative account credentials in the Run As dialog box. 
3. When Internet Explorer launches, type C:\ in the Address bar. 

After you follow these steps, Windows Explorer will appear in the same window, and it will be running with 
administrative privileges. 

Internet Explorer 7 
If you're using Internet Explorer 7, the steps for Internet Explorer 6 won't work because, as part of the new 
security features in version 7, Internet Explorer is no longer integrated with Windows Explorer. You must 
use the standard method for launching Windows Explorer with administrative privileges. Here's how: 

1. Log on to the computer with the Administrator account. 
2. Access the Control Panel and launch Folder Options. 
3. When you see the Folder Options dialog box, select the View tab. 
4. Scroll down the Advanced Settings list and select the Launch Folder Windows In A Separate 

Process check box, click OK, and then log off. 

The next time you work on that user's computer and need to perform an administrative task from within 
the limited user account, you can use Run As to launch Windows Explorer with administrative privileges. 

Get a GUI for RoboCopy in Windows XP 

Step up your copying operations with RoboCopy. This Windows 2003 Server tool is also at home on 
your Windows XP system. Learn why you'll want to tap into this free, powerful resource.  

Note: This tip applies to both Windows XP Home and Windows XP Professional. 

If you're like most IT professionals, you probably use the Windows Server 2003 Resource Kit Tool called 
RoboCopy with Windows XP. RoboCopy is an extremely powerful copy tool that allows you to perform 
more advanced copy operations than you can with Windows XP's standard copy tools. For example, with 
RoboCopy, you can create mirror images of large folder tree structures on the same computer or on a 
network drive. 

The only drawback to using RoboCopy is that you have to run it from the command line. This means that 
to use RoboCopy, you have to remember and type a lot of switches and parameters to really take 
advantage of all its features. 

Fortunately, Derk Benisch, a systems engineer with Microsoft's MSN Search group, created an add-in 
called RoboCopy GUI. This six-tabbed user interface makes configuring and using RoboCopy a real 
snap. Not only does the interface provide you with a large set of configuration options via check boxes, 
radio buttons, text boxes, and Browse dialog boxes, but it also can save your settings, which makes 
reusing the tool that much easier. Furthermore, RoboCopy GUI comes with a Help file and an extensive 
reference guide to help you get a handle on all that RoboCopy can do. 

You can download RoboCopy GUI. Keep in mind that you must have Microsoft .NET Framework version 
2.0 installed prior to installing RoboCopy GUI.  
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Take advantage of the Windows XP Start menu's pinned 
items list 

You're probably familiar with Start's left-hand menu—but do you know why the program list is divided 
in two? Here's what you need to know about the pinned items list found in Windows XP and how you 
can customize it to easily access your favorite programs.  

Note: This tip applies to both Windows XP Home and Windows XP Professional. 

The left panel of the Start menu consists entirely of a divided list of programs that Windows XP thinks will 
come in handy for you: the pinned items list above the separator line and the most frequently used 
programs list, displayed below the line. 

By default, Windows XP places links to your Internet browser and your e-mail application in the pinned 
items list and will place as many as 30 shortcuts to the programs you've recently used in the most 
frequently used programs list. (The most frequently used programs list is, by default, six shortcuts long.) 

To really take advantage of the Start menu as a launching area for all the programs you use most often, 
you can configure the entire left panel as a pinned items list. Here's how: 

1. Right-click the Start button and select the Properties command to display the Taskbar and Start 
Menu Properties dialog box. 

2. Click the Customize button adjacent to the Start Menu radio button to display the Customize Start 
Menu dialog box. 

3. In the Programs panel, use the Spin button to set the Number Of Programs On The Start Menu 
setting to 0. Click the Clear List button. 

4. In the Show On Start Menu panel, you can clear the Internet check box because the Internet 
Explorer icon already appears in the Quick Launch menu by default, and maybe even the E-mail 
check box, depending on how you launch your e-mail application. 

5. Click OK twice—once to close the Customize Start Menu dialog box and once to close the 
Taskbar And Start Menu Properties dialog box. 

6. Click the Start button and access the All Programs submenu. 
7. Locate and right-click on the shortcut to a program you use often and select the Pin To Start 

Menu command.  

You can pin as many as 30 of your most often used programs to the Start menu, depending on your 
screen resolution setting. With your actual favorite programs on the pinned items list, you can now really 
take advantage of the Start menu. 

Investigate Internet Explorer add-ons in Windows XP 

Note: This tip applies to both Windows XP Home and Windows XP Professional. 

When you're on the Internet, your Windows XP computer may be picking up harmless as well as 
potentially unwelcome add-ons. Greg Shultz explains how to evaluate which IE add-ons you have and 
what purpose they serve. 

When you visit various Web sites, your Windows XP computer may download add-ons—usually ActiveX 
controls designed to enhance your use of that particular site. Add-ons can include toolbars, software 
installers, and multimedia file viewers. However, some add-ons may be spyware, which could have 
devastating effects on Windows XP's performance. So it's worth your time to periodically investigate add-
ons in Internet Explorer to make sure that they are all legitimate. 
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Here's how: 

1. In Internet Explorer, go to Tools | Manage Add-ons. 
2. In the Manage Add-ons dialog box, make sure the Show drop-down is set to Add-ons That Have 

Been Used By Internet Explorer. 
3. Scan through the list and take note of each add-on's name, publisher, status, type, and file. 
4. If you discover an add-on you do not recognize, select it and then select the Disable option. Click 

OK. 
5. Point your browser to your favorite search engine and search for the add-on's name to see what 

you can learn about its origins. If you discover that it is indeed a legitimate add-on, simply return 
to the Manage Add-ons dialog box and re-enable the add-on. 

Determine whether USB 2.0 is on your Windows XP machine 

Before you connect a USB device to your Windows XP machine, learn how to determine whether a 
USB 1.1 or USB 2.0 controller is on your computer. 

Note: This tip applies to both Windows XP Home and Professional editions. 

If you plug a USB 2.0 device into a USB 1.1 port, Windows XP will display a warning message indicating 
that it will drop back to the slower data transfer speed. (USB 2.0 clocks in with a data transfer speed of 
480 Mbits/second to USB 1.1's 12 Mbits/second.) To find out what version of USB controller is on a 
computer before you connect a USB device to it, follow these steps: 

1. Press [Windows][Break] to access the System Properties dialog box. 
2. Select the Hardware tab and click the Device Manager button. 
3. When Device Manager appears, click the + sign next to the Universal Serial Bus Controllers 

branch. 

If you see an entry containing the words Enhanced USB Controller, the system has a USB 2.0 controller. 
If you see an entry containing the words USB Controller, the system has a USB 1.1 controller. 

Clear the Windows XP Run command's MRU list 

The most recently used list is designed to make it easier for you to launch the same Windows XP 
applications again and again—until the list gets so long you can't find anything. See how to set up a 
shortcut that clears the list from the Run command. 

Note: This tip applies to both Windows XP Home and Professional editions. 

If you regularly use the Run command to launch applications, you know that Windows XP keeps a record 
in the registry, called the MRU (most recently used) list, of all the applications you recently launched. 
When you have the Run dialog box open, you can access the MRU list by clicking the drop-down arrow 
adjacent to the Open text box. 

The MRU list is designed to make it easier for you to relaunch the same applications at a later date. 
However, this list can grow quite long, making it difficult to find what you want. 
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Fortunately, you can create a registry shortcut that clears the Run command's MRU list. To do so, follow 
these steps: 

1. Launch the Registry Editor (Regedit.exe). 

2. Go to HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\RunMRU. 

3. Right-click on the RunMRU key and select Export. 

4. Name the REG file Clear Run MRU, click the Save button, and close the Registry Editor. 

5. Open the Clear Run MRU.reg file in Notepad. 

6. Add a minus sign to the beginning of the key name just inside the square brackets. 

7. Delete all lines that follow the line containing the key path. 

8. Save the file and close Notepad. 

9. Reboot Windows (or at least log off and then log back on) for this change to become effective. 
Now, any time you want to clear the Run command's MRU list, simply locate and double-click on 
the Clear Run MRU.reg file. When you do so, the Registry Editor will display two dialog boxes: 
one that prompts you to confirm the operation and the other to let you know the operation was 
successful. 

 

 

Additional resources 
 TechRepublic's Downloads RSS Feed  
 Sign up for TechRepublic's Downloads Weekly Update newsletter 
 Sign up for our Windows XP newsletter 
 Check out all of TechRepublic's free newsletters 
 "Hacking Windows XP: Answers from the experts" (TechRepublic download) 
 "Windows XP services that can be disabled" (TechRepublic download) 
 "10 things you can do when Windows XP won't boot" (TechRepublic download) 

Version history 
Version: 1.0 
Published: March 27, 2007 

Tell us what you think 

TechRepublic downloads are designed to help you get your job done as painlessly and effectively as 
possible. Because we're continually looking for ways to improve the usefulness of these tools, we need 
your feedback. Please take a minute to drop us a line and tell us how well this download worked for you 
and offer your suggestions for improvement. 

Thanks! 

 

—The TechRepublic Downloads Team 
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